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About Dataforth Corporation 
 
“Our passion at Dataforth Corporation is designing, manufacturing, and marketing the best possible signal 
conditioning and data communication products. Our mission is setting new standards of product quality, 
performance, and customer service.” Dataforth Corporation, with over 20 years experience, is the 
worldwide leader in Instrument Class™ Industrial Electronics—rugged, high performance signal 
conditioning and data communication products that play a vital role in maintaining the integrity of 
industrial automation, data acquisition, and quality assurance systems. Our products directly connect to 
most industrial sensors and protect valuable measurement and control signals and equipment from the 
dangerous and degrading effects of noise, transient power surges, internal ground loops, and other 
hazards present in industrial environments. 
 
Dataforth spans the globe with over 50 International Distributors and US Representative Companies. 
Our customers benefit from a team of over 130 sales people highly trained in the application of precision 
products for industrial markets. In addition, we have a team of application engineers in our Tucson factory 
ready to address and solve any in-depth application questions. Upon receipt of an RFQ or order, our 
Customer Service Department provides fast one-day response of delivery information. We maintain an 
ample inventory that allows small quantity orders to be shipped from stock. 
 
Dataforth operates under an ISO9001:2015 quality management system. 

 
 
 

Contacting Dataforth Corporation 
 

Contact Method Contact Information 
E-Mail: Technical Support support@dataforth.com 

Website: www.dataforth.com 

Phone: 520-741-1404 and toll free 800-444-7644 

Fax: 520-741-0762 

Mail: Dataforth Corporation 
3331 E. Hemisphere Loop 
Tucson, AZ 85706 

 
Errata Sheets 
 

Refer to the Technical Support area of Dataforth’s web site (www.dataforth.com) for any errata 

information on this product. 

mailto:support@dataforth.com
http://www.dataforth.com/
http://www.dataforth.com/
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Introduction 

1.1   Overview 

 
ReDAQ® Shape Software for the MAQ®20 Industrial Data Acquisition and Control System is Dataforth’s 
out-of-the-box data acquisition software which provides the easiest and most efficient development tool to 
create, save, and open graphical user interface projects as well as to test, process, and analyze acquired 
data.  It can also log data to the hard drive, and copy, and delete data at runtime.  Simple data acquisition 
starts with a built-in function (e.g., scope, I/O special function, and data view spreadsheet) in the 
Acquire and Analyze panels which can be used without setup and configuration.  In addition, it takes only 
three easy steps to create Present panels for projects using 18 Tools for I/O control and monitoring and 
powerful functions like automatic control loops and timers. 
 
For easy data acquisition without detailed setup and configuration: 
 

• Power the system and select the communication options from the Acquire panel. 
 

 

 
 
 

• Click on the [Connect] or [RUN] button , then view and process the data on the 
Acquire and Analyze panels.  The main system panel will display all installed MAQ®20 I/O 
modules.  The status bar at the bottom of the panel provides indications of current activities 
including Edit Lock, Communication Status, Scan Interval, Running Activity, and Control 
Loop/Alarm Output Activity. 
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To create Present panels for application projects: 
 

• Select Acquire panel for quick setup and click on the [Connect] button to connect to the MAQ®20 
system as well as testing and acquisition of data. 

• Select Analyze panel to allow data logging, real-time analysis, and data processing. 

• Select Present panel to build and create custom graphical user interfaces.  
 
After selecting a Present panel, use Tools such as Switch, Scope, LED, etc. to build a 

project.  Open the Toolbox with the  icon, select a tool, then click in the Present panel 
to place the tool in the project.  Double click on a Tool in the Present panel to open the 
properties window.  Change properties as desired and click the Start button to run.  See 
Section 5 for details on creating a Present panel. 
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The following illustrates a Present panel project: 
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ReDAQ® Shape Software for MAQ®20 offers 18 different types of Tools for building applications: 
 
The Graph group contains: 

• Chart Recorder 

• Scope 

• XY plot 

• Discrete Waveform Graph 
 
The Knob group contains: 

• 5 styles of Knobs 
 
The Meter group contains: 

• 4 styles of Meters 
 
The Gauge group contains: 

• 6 styles of Gauges 
 
The Tank group contains: 

• 6 styles of Tanks 
 
The Slide group contains: 

• 6 styles of Slides 
 
The Thermometer group contains: 

• 6 styles of Thermometers 
 
The Numeric Edit group contains: 

• 4 styles of Numeric Edit 
 
The Switch group contains: 

• 14 styles of Pushbutton, Slide, Rocker, and Toggle Switches 
 
The LED group contains: 

• 4 styles of LEDs 
 
The Other Controls group contains: 

• Label 

• Button with High Level Timer functions 

• Group Box 

• Picture Box 

• Text Box 
 
 
All the Tools are easily selected to create, move, resize, cut, copy, paste, and delete.  Double click on the 
selection to set its properties.  These Tools also support many graphical file formats, so users may use 
common software to create a graphical representation of a process and load it into ReDAQ® Shape 
Software for MAQ®20. 
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1.2   Developer Version and User Version 

 
There are two versions of the software, Developer and User.  The Developer version is fully functional 
with the capability of creating a project, configuring the Tools, and setting up the parameters of MAQ®20 
COM and I/O modules. The User version can only run finished projects that were created using the 
Developer version and is for use in applications where a user does not have the ability to modify a 
project.  
 
Both versions of ReDAQ® Shape Software for MAQ®20 can be installed on the same computer.   
 
After a project is complete, it can be saved as a User project and distributed.  A User project can only be 
run with the User version of ReDAQ® Shape Software for MAQ®20. 
 
A ReDAQ® Shape for MAQ®20 project file has two parts: 
 

• A projects file with extension.rsd (Developer version) or .rsu (User version).  Examples are 
‘project1.rsd’ or ‘project1.rsu’. 

• A folder which includes all the image and text files of the project. The folder name is <project 
name> + ‘Images’ (Developer version) or <project name> + ‘ImagesUser’ (User version).  
Examples are ‘project1Images’ or ‘project1ImagesUser’. 

 

1.3   Minimum Host Computer Requirements 

 
Before installing ReDAQ® Shape Software for MAQ®20, verify that the host computer meets the following 
minimum requirements: 
 

• Microsoft Windows 2000/XP/Vista/Win7/Win10/Win11 operating system. 

• Video display – 800x600, 256 color (16-bit recommended), or higher. 

• Minimum of 256MB of RAM (512MB or higher recommended). 

• Minimum of 400MB of free hard disk space. 
           

1.4   Installation 

 
To install ReDAQ® Shape Software for MAQ®20, complete the following steps: 
 

• Download the Developer version and/or User version from the Dataforth website, 
www.dataforth.com.   

• Extract the files from the downloaded .zip file and run setup.exe. 

• Follow the installation instructions in the setup program. 
 
If the system will be used with a USB connection the USB Driver must be installed prior to connecting the 
system to the computer.  The ReDAQ® Shape Software installer will present the option to install the USB 
driver during program installation if the driver is not already present on the host machine.  
 
 

1.5   License Unlock Code 

 
ReDAQ® Shape Software for MAQ®20 is available for download free of charge from the Dataforth 
website, www.dataforth.com.  It is fully functional software and can be used for evaluation, testing and 
development, but will only run for 30 minutes.  Order the License Unlock Code, part number MAQ20-940 

http://www.dataforth.com/
http://www.dataforth.com/
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(Developer Version) and/or MAQ20-941 for (User version) from Dataforth Corporation to enable unlimited 
use. 
 
The License Unlock Code is tied to the serial number of the COM module of MAQ®20 Data Acquisition 
System being used.  To install the License Unlock Code and hardware serial number in the software, 
open the Enter License Unlock Code window from the Help menu, then type or copy/paste the 
information into the fields provided.  Up to 10 unlock codes can be entered to interface to up to 10 
MAQ®20 Data Acquisition Systems.  The MAQ®20 COM module serial number must have the format of a 
7-digit main number followed by a 2-digit suffix.  If the main number has fewer than 7-digits or the suffix 
has a single digit, use leading zeros to obtain the correct format (i.e., serial number 12345-6 must be 
entered as 0012345-06). 
 

 
 

 
 

1.6   Related Documents 

 
The following documents are available for download from the Dataforth Corporation website, 
www.dataforth.com: 
 

• MA1036 MAQ20 Quick Start Guide  
• MA1038 ReDAQ® Shape for MAQ®20 User Manual (this manual) 
• MA1039 MAQ20 LabVIEW VI Examples User Manual 
• MA1064 MAQ20 Python API User Manual 
• MA10xx MAQ20 Hardware User Manual (I/O Module specific) 
• MA1056 PID Controller User Manual 
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The following documents are available from Modbus IDA ( HUwww.modbus.orgUH): 
 

• Modbus Application Protocol Specification 
• Modbus over Serial Line Specification & Implementation Guide 
• Modbus Messaging on TCP/IP Implementation Guide 

 
The following Tools and documents are available from FieldTalk ( HUwww.modbusdriver.comUH): 
 

• Modbus Protocol Drivers and DLL Libraries 
• FieldTalk User Manual 

 
The following Tools and documents are available from National Instruments ( HUwww.ni.comUH): 
 

• Free Modbus Protocol Drivers VI’s and Examples 

• LabVIEW User Manual 
• Measurement Studio User Manual 

 
 

2.0   ReDAQ® Shape for MAQ®20 Integrated Development Environment 

2.1   Start Window 

 
After starting ReDAQ® Shape for MAQ®20, the setting dialog box will be displayed for selecting settings, 
configurations of development environment, and system parameters.  The user can select the previous 
project settings [Yes] or the MAQ®20 system hardware settings [No].  
 
 

                              
 
 
The Interactive Development Environment (IDE) of ReDAQ® Shape for MAQ®20 provides a user friendly 
and comprehensive interface with easy-to-use pull-down menus, convenient toolbars, and three 
development panels [Acquire-Analyze-Present], which provide easy methods to setup, configure, and 
operate the MAQ®20 Data Acquisition System.  Users can develop application specific interfaces, 
projects, and automatic control loops to process, analyze, and acquire data. 
 

 
 
 

  

http://www.modbus.org/
http://www.modbusdriver.com/
http://www.ni.com/
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2.2   Software Menus 

There are 5 main pull-down menus:  
 

File: 
• Open new project - Start a new project and reset Acquire, Analyze, and Present panels to 

default settings. 
• Open existing project – Open an existing project that was previously saved. 
• Save project - Save the project to a file <filename>.rsd.  Each project also includes image files 

and text files in a separate folder titled <filename>Images. 
• Save project for user only - Save the project to a User file <filename>.rsu.  Each project also 

includes image files and text files in a separate folder titled <filename>ImagesUser. 
• Exit - close ReDAQ® Shape for MAQ®20. 

 

Edit: 
• Cut Tool - Delete the selected Tool and send it to the clipboard. 
• Copy Tool - Copy a selected Tool and send it to the clipboard. 
• Paste Tool - Paste a Tool to a Present panel. 
• Delete Tool - Delete a Tool from a Present panel. 
• Undo Delete Tool - Undo the last deleted item on the Present panel. 
• Bring Tool to Front - Bring item to front/top layer of Present Panel. 
• Edit Lock/Unlock - Select lock or unlock editing functions. 

 
View: 

• Present Panel - Add or remove a Present panel. 
• Acquire Panel - Show or hide the Acquire panel. 
• Analyze Panel - Show or hide the Analyze panel. 
• Toolbox - Open or close the Toolbox. 
• Advance Settings – Enable or disable Manual Module Registration Mode or Modbus Logger 

functionalities. 
 
Run: 

• Start - Setup all the parameters of the MAQ®20 from the Acquire panel and run. 
• Pause - Keeps the parameter settings and pauses run.  Click again to continue. 
• Stop - Stop and reset all parameters. 

 
Help: 

• ReDAQ® Shape for MAQ®20 User Manual 
• Enter License Unlock Code 
• About - ReDAQ® Shape for MAQ®20 version information. 

 

2.3   Tool Bar 

 
There are 14 convenient tools located on the tool bar: 
 

 
 
 Open New Project 
 Open Existing Project 
 Save Project 
 Cut 
 Copy 
 Paste 
 Delete 
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 Undo Delete 
 Bring Tool to Front 
 Edit Lock/Unlock 
 Toolbox Open/Close 
 Start 
 Pause 
 Stop 
 

2.4   Panel – Select 

 
A given project can have one Acquire panel, one Analyze panel, and up to 20 Present panels. 
 

 
 
The Acquire and Analyze panels can be hidden or shown using the View pull-down menu.  
The Present panels can be added, removed, or renamed. 
 

2.5   Status and Message Bar 

 
The status and message bar are located at the bottom of the main software panel.  It includes 5 types of 
information. 
 

 
 

• Edit - Shows the edit lock/unlock status. 
• Communication - Shows the connection status and any communication error messages. 
• Scan interval - Shows the current scan interval setting. 
• Running activity - Shows start, pause, or stop activity using a progress bar. 
• Control Loop/Alarm Output activity - Shows the Control Loop or Alarm Output activity by 

indicating analog channels which have reached a specified preset alarm condition.  None = no 
channels have current alarm activity. 

 

3.0   Setup, Configure and Acquire Data in Acquire Panel 

3.1    Acquire Panel 

 
The Acquire panel provides setup, configuration, and the ability to read and write data to/from the 
MAQ®20 Data Acquisition System.  A system is made up of one communications module and up to 24 I/O 
modules. 
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Before an application can be run, the system must be configured using the Acquire panel.  
 

• Enable system connected: Enabled (Default).   

• System Name: System (Default). 

• Select the communication port for the system: Ethernet (Default), USB, or Serial. 
IP Address: 192.168.128.100 (Default).  
USB: Port 1 (Default). 
Serial port name:  COM1-COM20.    
Target ID: 16 (Default). 
Serial port baud rate:  921600, 460800, 230400, 115200 (Default), 57600, 38400, 19200, 9600, 
4800, 2400.  
Parity:  EVEN (Default), NONE, and ODD. 

• Select system run interval in milliseconds: 100 (Default). 

• Select communications timeout in milliseconds: 2000 (Default). 

• Select reconnect timeout in seconds: 10 (Default).  
 

 
To establish communications with the system, click on the [Connect] button. When using the Ethernet 
interface, up to four simultaneous socket connections are supported and each socket can process up to 
four simultaneous Modbus TCP transactions. Serial communications over RS-232 or RS-485 can be run 
at baud rates as fast as 921.6kbps. 
 
The communications module will automatically detect which MAQ20 I/O modules are installed (TC, VDN, 
Vout, DIOL, etc.) and the software will generate a graphical representation of the entire system.  The 
individual I/O modules in the system can be set up by clicking on the image of the modules to open a 
configuration panel specific to each I/O module type. 
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After setup, the Acquire panel can be hidden using the View pull-down menu as follows: 
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3.2   Communication Module 

 
To setup and configure the communications (COM) module, click on the COM module graphic.  The COM 
module setting panel has four tabs [System Summary], [Setup COM], [SD Memory Card], and [Data 
Converter].   
 

• System Summary Tab: 
 

 

 
 

Basic information for all modules in the system are displayed at the top of the panel including 
model number, serial number, date code, firmware revision, and Modbus start address in the 
system map. 
 
When power is applied for the first time to a system, the COM module automatically registers all 
I/O modules in the system.  The registration sequence by slot number is displayed in the COM 
module configuration panel.  This sequence may not match the actual physical sequence of the 
I/O modules in the system.  To change the slot number in the software, click on the row to select 
the module, then use the [Up] and [Down] buttons to move the module to the slot number which 
matches the actual physical location.   
 
Click on the [Save] button to save the changes.  The system configuration is now stored in the 
COM module’s nonvolatile memory and I/O modules will be shown in the same slots for all 
subsequent power cycles. 
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• Setup COM Tab:  
 

 

 
 

Communication Parameters such as Slave ID, Serial Baud Rate, Parity, Gratuitous ARP, IP 
Address, Gateway, and Subnet mask are modified using this panel.  Click on the [Save Settings 
to Module Memory] button to store changes in the COM module’s nonvolatile memory.  Changes 
made to the communications settings do not take effect until the system power has been 
removed and restored.  
 
Real Time Clock: The Real Time Clock can be set based on the host computer’s time/date by 
clicking the [Set to System Date/Time] button and then clicking the [Save Settings to Module 
Memory] button.  The Real Time Clock can also be set manually by selecting the [Manual Set 
RTC] button, editing the time fields, and then selecting the [Save RTC] Button.  
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• SD Memory Card Tab: 
 
 

 
 
 

This tab provides a simple interface to set up data logging parameters, start/stop data logging, 
and verify logging activity.   

 
Enter the desired file name in the File Name text box.  The filename must be a maximum of 8 
characters and follow standard MS Windows naming convention.  The default filename is ‘File1’. 
 
Time between logged samples is entered in the Scan Interval input box.  100ms is the minimum 
and default interval value for this field. Number of Scans specifies the total number of data 
retrieval events to occur within the time frame specified by the Scan Interval value. The default is 
100 scans. 

 
Configuration of data to be logged is initialized through a configuration window that appears upon 
clicking the [Configure] button.  The configuration pop-up window allows selection of logging from 
all attached modules. Quantity of logged registers defaults to values related to available channels 
on the module. Refer to the MA10xx MAQ®20 Hardware User Manuals for a complete listing of 
Modbus register addresses. 

 
To start logging data, click the [Start Log] button.  
 
To stop logging data, click the [Stop Log] button. 
 
Logging in continuous loop allows for a new file to be created upon completion of the specified 
logging parameters. If Name Wraparound is selected along with the Logging in a continuous loop 
option, each new filename will be incremented by one integer value. 
 
NOTE:  To retrieve data from the micro-SD card, remove it from the system, place it in the 
provided USB adapter and read the card using the host computer or another appropriate system. 
Alternatively, data can be retrieved using the functions in the Data Converter tab if the system is 
connected through TCP.  



MA1038  ReDAQ® Shape Software for MAQ®20 User Manual 

 

 Page 15 of 66 

The Automatic Log feature is a quick method for setting up SD card logging of all modules in the 
system.  The feature can be enabled by marking the checkbox in the Automatic log box.  
 

• Data Converter Tab: 
 

 
 

This tab provides a simple interface to access logged data from the micro-SD card when the system 
is connected through TCP. Click the [SD Card Directory] button to display the file contents currently 
present in the micro-SD card.  Individual files can be downloaded to the host system by click on the 
desired file in the SD Card Directory Listing window and then clicking the [Download File] button. 
Alternatively, all files can be downloaded at once by clicking the [SD Card Directory] button then 
clicking the [Download All] button.  Clicking the [Show in Explorer] button will open the downloaded 
file location in the host operating system. 

 
Individual file contents can be viewed without first downloading by use of the [Display File Contents] 
button after selection of the specified file in the SD Card Directory Listing window.  
 
Files downloaded from the micro-SD card contain data in raw count format.  Select the desired file in 
the SD Card Directory Listing window then click the [Convert to Engineering Units] button to convert 
the data in the file to engineering units.   
 
Files can be deleted from the micro-SD card by clinking the [SD Card Directory] button then selecting 
a file in the SD Card Directory Listing window, and subsequently clicking the [Delete File] button.  

 
Micro-SD card content can also be accessed in-system during system idle or system operation using 
the MAQ®20 built in FTP Server.  FTP server credentials can be entered in the fields located within 
the FTP server login credentials box.  The FTP server in each MAQ20-COMx module supports 
Passive and Active connections with limited FTP commands. 
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3.3   Analog Input Modules 

 
The Analog Input Module configuration panel has three tabs [Setup], [Scale Data], and [Control Loop, 
Trigger and Alarm] that provide a simple interface to configure and collect data from analog input modules 
such as MAQ20-MVDN, -VSN, -VDN, -ISN, -IDN, -RTD31, -RTD41, -BRDG1, -JTC, -KTC, -TTC, -RSTC, 
etc.  To open the analog input module configuration panel, click on the input module graphic in the 
system representation. 
 

• Setup Tab: 
 

 
 

Each channel can have a unique User Tag Name.  The system automatically assigns the default 
tag name when the system is first connected.  The format of the default tag name is: 
 
system name _ device name _ slot number _ channel number   
 
For example, in the default name 1_VDN_2_0: 
1 = System 1 
VDN = MAQ20-VDN module 
2 = Module is in system Slot 2 
0 = MAQ20-VDN channel 0 
 
To change the tag name, enter the new name in the User Tag Name text box for the channel.  
References to this channel in other panels will use this entered tag name. 
 
Current, Average, Maximum, or Minimum data for each channel can be displayed based on 
selection.  Click on the Select selection box and choose the desired data. 
 
Average Weight can be set independently for each channel.  Use the Avg Weight selection box to 
set the desired value. 
 
To reset the Maximum and Minimum value, click on the reset button of the channel. 
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Input Range can be set independently for each channel.  Use the Input Range selection box to 
set the desired value. The data scale also automatically reset when the input range changed. 
Accuracy of MAQ®20 modules are specified as percent of span; selecting the smallest input 
range for a given channel will produce more accurate readings.  

  
Control Loop or Alarm Output function for a given analog input channel is configured by selecting 
the desired function from the selection box.  Alarms can be Tracking or Latched with High, Low, 
High-Low, High-High, Low-Low, or High-High Low-Low limits.  Alarm limit values are set using the 
Control Loop / Alarm Output tab.  
 

  
 
 
Alarms can be reset with the Reset Latched Mode Alarm button or by assigning reset function to 
a Button Tool in the user project.  
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• Scale Data tab: 
 

 
 

The MAQ®20 analog input values have 12-bit resolution plus sign, which equates to a full-scale 
range of -4016 to 4016 counts.  This count range can be scaled to any engineering units on a 
per-channel basis.  By default, the analog input channels are scaled to the selected input range.  
For example, if an input range of -5V to +5V is selected for a given channel, then collected data 
for that channel is automatically scaled to -5V and +5V. 

 
Analog input data in counts always represents the full range of the signal applied to input 
channel.  How this data maps to actual engineering units depends the internal mapping of the 
signal range to counts and the scale setting chosen. 

 
Example:  
Channel 0 is connected to a sensor which outputs 0V to +5V to represent 0 to 120 MPH.   
Data from channel 0 of a MAQ20-VDN input module is read.  
Channel 0 input range set to -5V to +5V.  
A data value of 0x0000 (0V) corresponds to an input of 0 MPH. 
A data value of 0x0FB0 (+5V) corresponds to an input of 120MPH.  
To scale the 0 to +5V input range to a linear representation of the 0 to 120MPH input range, enter 
the data shown below: 
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• Control Loop / Alarm tab: 
 

 
 

The Control Loop / Alarm tab provides a simple interface to select control loop or alarm output 
states of High, Low, High-High, or Low-Low, as well as to configure the output active states and 
set the alarm limits and dead-band.  The Control Loop and Alarm outputs can be mapped to 
Discrete Output channels, and/or to Analog Output channels. 

 
To use the Control Loop or Alarm Output function: 

 
1. Select the Control Loop or Alarm Output mode for analog input channels in the Setup tab. 
 

   

 
 
 
 



MA1038  ReDAQ® Shape Software for MAQ®20 User Manual 

 

Page 20 of 66  

2. Configure the channel Control Loop or Alarm Output active state, Discrete Output and/or 
Analog Output mapped channel, Alarm Limits, and Deadband parameters in the Control Loop 
/ Alarm Output selection box. 

 

  
 
        

3.4   Analog Output Modules 

 
The Analog Output Module configuration panel has two tabs [Setup] and [Scale Data] that provide a 
simple interface to configure and write data to analog output modules such as MAQ20-VO and -IO.  To 
open the analog output module configuration panel, click on the output module graphic in the system 
representation. 
 
 

• Setup Tab: 
 

 
 

Each channel can have a unique User Tag Name.  The system automatically assigns the default 
tag name when the system is first connected.  The format of the default tag name is: 
 
system _ device name _ slot number _ channel number 
 
For example, in the default name 1_VO_3_0  
1 = System 1 
VO = MAQ20-VO module 
3 = module is in system Slot 3 
0 = MAQ20-VO channel 0 
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To change the tag name, enter the new name in the User Tag Name text box for the desired 
channel.  References to this channel in other panels will use this entered tag name. 

 
Data entered in the Output Data box will be written to the analog output channels when the 
project execution is started.  

 
Default Output Data are user defined values which are the known safe analog output values in 
case of loss of communication from the host or accidental power cycling of the MAQ®20 Data 
Acquisition System.   
 
Default output values are applied to the analog output channels when: 

o System power is turned on. 
o ReDAQ® Shape Software for MAQ®20 is stopped. 
o Communications between the host computer and the hardware are lost. 

 
To set the default outputs, enter the desired value into the Default Output Data box, then 
click on the [Save Default Output / Range to EEPROM] button.  

 
Buffer Scan Mode is used to output a specified data sequence to the output channels.  To 
configure the buffer mode, ensure the active project is stopped, select Buffer Scan Mode, and set 
the output interval between data point writes in milliseconds.  Program the output data for each of 
the channels by entering the data into the Buffer Mode Output Data text box, or load the data 
from a text file. 

 
Data points must be comma delimited.  The last character in a sequence indicates how the data 
is to be output.  If the last value is the character ‘S’, the output scan will stop upon completion of 
the specified sequence.  If the last value is the character ‘R’, the output scan will loop back to the 
starting point and continue to run the specified sequence until manually stopped by the user. 
 
Output data format: 
Value 1, Value 2, Value 3,…,Value n, S → Output the data sequence once, then stop. 
Value 1, Value 2, Value 3,…,Value n, R → Output the data sequence continuously. 

 
Example 1:   
Analog output range set to 0V to +5V 
Data = [0,1,2,3,4,5,R]  
A stair step-up waveform will be output continuously. 

 
Example 2:   
Analog output range set to 0V to +5V 
Data = [5,4,3,2,1,0,S]  
A stair step-down, one shot waveform will be output. 

 
To save or retrieve the programmed output data from the host computer, click on the [Save Burst 
Output Data to File] or [Load Burst Output Data from File] button. 

 
 
 
 
 
 
 
 
 
 
 



MA1038  ReDAQ® Shape Software for MAQ®20 User Manual 

 

Page 22 of 66  

 

• Scale Data tab: 
 

 
 

MAQ®20 analog output data values have 12-bit resolution, which equates to a full-scale range input of 
98 to 3998 counts.  This count range can be scaled to any engineering units on a per-channel basis.  
The default output range for the voltage output module is -10V to +10V and the default scale factor is 
1, which yields an output range of -10V to +10V.  This mapping can be changed using the scale factor. 

 
 

Example:  
A voltage output module is configured for -10V to +10V output range. 
Data in counts is written to Channel 0. 
A data value of 0x0062 corresponds to an output of -10V. 
A data value of 0x0F9E corresponds to an output of +10V.  
To scale the -10V to +10V output range to a linear representation of a -100°C to +300°C output range, 
enter the data shown below: 

 

 
 

3.5   Discrete Input-Output Module  

 
The Discrete Input-Output configuration panel has four tabs [Setup], [Special Function], [Special 
Functions I/O Map for DIOL], and [Special Functions I/O Map for DIOH] which provide a simple interface 
to configure and operate the Discrete I/O Channels and Special Functions.  To open the discrete input-
output module configuration panel, click on the DIO module graphic in the system representation.  
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• Setup tab: 
 

    
 

Each channel can have a unique User Tag Name.  The system automatically assigns the default 
tag name when the system is first connected.  The format of the default tag name is: 
 
system _ device name _ slot number _ channel number 
 
For example, in the default name 1_DIOL_Out_4_0 
 
1 = System 1 
DIOL = MAQ20-DIOL module 
Out = Discrete Output Channel 
4 = module is in system Slot 4 
0 = MAQ20-DIO channel 0 
 
To change the tag name, enter the new name in the User Tag Name text box for the desired 
channel.  References to this channel in other panels will use this tag name. 

 
The user can view discrete input data in the DIO Status data display boxes and write discrete 
output data by entering a value of 0 or 1 in the Output Data boxes.  

 
Default Output Data and Default DIO States are user defined values which are the known safe 
discrete output values in case of loss of communication from the host or accidental power cycling 
of the MAQ®20.   
 
Default output values are applied to the discrete output channels when: 
 

o System power is turned on. 
o ReDAQ® Shape Software for MAQ®20 is stopped. 
o Communications between the host computer and the hardware are lost. 

 
To set the default outputs, enter the desired value into the Default Output Data box and then click 
on the [Save Default to Module Memory] button.   
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• Special Function tab: 
 

 
 

To configure the Discrete I/O Special Functions, first ensure the active project is stopped.  The 
Discrete Input-Output channels do not need to be configured or set with initial I/O states because 
ReDAQ® Shape Software for MAQ®20 will do this automatically when a particular Special Function is 
chosen.  
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Example 1:  
Frequency Generator: 

• Select the [Frequency Generator] function button in the Timer 0 block. 

• Enter the desired output frequency. 

• Set the Disabled/Enabled/Button Tool Trigger state to Enabled in the Timer 0 dropdown 
menu. 

• Click the Start button.   
 

 
 

 
 
 

Example 2:  
Pulse/Frequency Counter: 

• Select the [Pulse/Frequency Counter] function button in the Timer 1 block. 

• Enter Input Polarity, Timer Gate, and Ticks per Revolution. 

• Set the Disabled/Enabled/Button Tool Trigger state to Enabled in the Timer 1 dropdown 
menu. 

• Using the Toolbox, insert a Button and Numeric Edit box on the Present panel. 

• Double-click on the Button and Numeric Edit box to open the properties for each and connect 
them to the Pulse/Frequency/Counter special function. 

• Click the start button. 
 

  
 

• The Button will start and stop the function and the Numeric Edit box will display the 
frequency. 
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• Special Functions I/O Map for DIOL Tab: 
 

 
 

The Special Functions I/O Map for DIOL tab provides information on special function configurations 
and channel properties specific to the -DIOL module.  
 

 
• Special Functions I/O Map for DIOH Tab: 
 

 
 

The Special Functions I/O Map for DIOH tab provides information on special function configurations 
and channel properties specific to the -DIOH module.  

 



MA1038  ReDAQ® Shape Software for MAQ®20 User Manual 

 

 Page 27 of 66 

4.0   Test, Process, and Analyze Data in Analyze Panel 

4.1   Analyze Panel 

 
The Analyze panel has four tabs to test, process, and analyze data from the MAQ®20 Data Acquisition 
System without any programming.  
 
 View Raw Data 
 View Analog Input/Output Channels 
 View Discrete DIO Channels 
 Read / Write Modbus Registers 
 

 
 

 
Once communications with the system have been configured and established, the tools on the Analyze 
panel can be used at any time by pressing the Start button. 
 
 

 

 
The Analyze panel can be shown or hidden by making the appropriate selection from the View pull-down 
menu. 
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4.2   View Raw Data 

The View Raw Data tab shows data read from all analog and discrete input/output channels on the 
MAQ®20 Data Acquisition System regardless of whether they are configured.  Data is time stamped and 
the display is continuously updated while the system is running.  Data can be saved to a text or Excel file 
on the host computer for storage or later processing. 
 

   

   
 

• To save collected data to a file on the host computer, select ‘Save to file’ from the drop-down 
selection box.  This will save raw data to a text file without units.  Select ‘Save to file with unit’ if it 
is desired to have units on the collected data saved to the text file.  Text file size is only limited by 
the host computer hard drive available space.  The rate at which data is logged is set by the 
system sampling interval.  

• The grid display can show data with or without units or can be disabled using the selection box. 

• The filename and path for the logged data file is shown in the box at the top of the panel.  Use the 
[Change File Name] button to select a new filename.  Standard MS Windows naming convention 
applies. 

• The Data Save Mode selection box allows the choice of saved data modes of Over Write, 
Append, Auto File Increment, or Continue. 

• The text file displayed in the box at the top of the panel can be opened using the [Open Data File] 
button. 

• To copy data to another application, first select the rows of data in spreadsheet or click the box at 
the top left corner of the grid to select all rows, then click on the [Copy to Clipboard] button.  The 
data is now in the clipboard and can be pasted into other software applications which accept data 
in space delimited .txt format.  

• To delete data from the grid display, select the row or rows of data to be deleted and click on the 
[Delete Rows Data] button. 

• To delete all data in the grid display, click on the [Delete All Data] button. 

• The limit for data shown in the grid display and in the graphs on the View Analog Input Channels 
tab and View Discrete I/O Channels tabs is set using the History Capacity box.  The default 
setting is 1000.  Once the limit is reached, data will be cleared from the grid display and graphs 
and will start over from 1. 
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4.3   View Analog Input Channels  

 
The View Analog Input Channels tab provides graphical views of acquired data.   Seven different modes 
are available for optimal data display: 
 
 Fixed 
 AutoScaleLoose 
 AutoScaleExact 
    ScopeChart 
    StripChart 
 AutoScaleVisibleLoose 
 AutoScaleVisibleExact 
 

 
 

• Analog input channels displayed on the graph are enabled using the Channel Select checkboxes. 

• X and Y axis limits can be set using the pull-down boxes. 
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4.4   View Discrete I/O Channels Tab 

 
The View Discrete I/O Channels tab provides a graphical view of the data for the five discrete input and 
output channels on the MAQ20-DIOx module.  Data can be displayed or hidden using the +/- box at the 
top left corner of the plot.  The horizontal hash mark in the left-hand legend represents the midscale value 
for each channel for determination of channel low/high state. 
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4.5   Read / Write Modbus Registers 

 
The Read / Write Modbus Registers tab provides a simple interface to directly read and write any Modbus 
register in the system.  Through this interface, the user can setup, configure, test, and operate the 
MAQ®20 data acquisition system.  The Read function can read up to 40 registers at once and the Write 
function can write to 20 registers at once.   
 
For detailed information on the MAQ®20 Modbus commands, refer to MAQ®20 Hardware User Manuals 
specific to each module type. 

 
 

To Read from the Modbus registers: 
 

• Enter the Start Address to read from and the quantity of addresses to read. 

• Click on the [Read] button. 

• If the project is running, current data will be displayed each time the [Read] button is pressed.  If 
the project is stopped, the last contents of the register will be displayed. 

• Data displayed is the decimal value of the ASCII character.  
 
To write to the Modbus registers: 

 

• Enter the Start Address to write to and quantity of addresses to write. 

• Enter the data to write using the text boxes.  In each box, enter the decimal value of the ASCII 
character.  

• Click on the [Write] button. 
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5.0   Create User Interfaces and Edit Tools in the Present Panel 

5.1   Present Panel 

 
The Present panels allow the user to create up to 20 separate displays to interface to a MAQ®20 Data 
Acquisition System, all of which can run simultaneously.  Examples of interfaces include instrument 
panels, indicators, graphical displays for data monitoring, buttons for control, control loops, and alarms for 
processes.  Panels are added and removed using the View drop-down menu.  Displays and Tools are 
added using the Toolbox and can be resized, moved, cut, copied, pasted, and deleted.  Once an interface 
is developed, it is saved to a project file.  Properties of the displays, Tools, and Present panel can be 
modified by double clicking on the item. 
 
The graphic below shows an example of a Present panel which has been set up with a custom 
background and a dial gauge to display scaled data from an analog input channel. 
 

 
 
To start editing in a Present panel, first verify the Edit: Lock/Unlock status on the bottom left corner of the   
panel.  
 

 
 

To lock or unlock Panel editing, click on the Lock/Unlock button on the toolbar.  or select Edit 
Lock/Unlock from the Edit pull-down menu. 
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Present panel appearance can be customized for a given application.  Plant schematic drawings, images, 
or pictures can be used as background and the panel name can be changed. 
 
To setup the properties of Present panel, double click on a blank area in the panel and the Present panel 
Properties window will appear. 
 

 
 
There are seven categories in the Present panel properties: 
 

• Accessibility 

• Appearance 

• Behavior 

• Data 

• Focus 

• Layout 

• Miscellaneous 
 
Only Appearance properties can be changed.  All others are fixed. 
 
The Present panel name is found in the Text field and can be changed by highlighting the field and 
entering the desired text.  Font and foreground colors are configured using the appropriate fields. 
 
A custom background image can be loaded by clicking on the background image box and selecting the 
image from the host computer.  All common image formats are accepted.  Background image variable 
parameters are none, tile, center, stretch, or zoom.  To delete the background image, click on the Delete 
Backgroundimage] button.  
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5.2   Toolbox Usage 

 
The Toolbox contains 18 different Tools, many of which have several different styles.  To open or close 
the toolbox window, click on the toolbox icon, or select Toolbox from the View pull-down menu. 
 

 
 

 
To select different tools, use the tools scroll bar at the top of the window. 
 
 

  
 
 
To select a Tool, click on the image of the Tool and it will be highlighted. 
 
To add a Tool on the Present panel, position the mouse pointer on Present panel location where the tool 
is to be placed, click the left mouse button to place the tool, hold the mouse button and drag to establish 
the desired size of the Tool.   
 
To reposition the Tool, click and hold the left mouse button on the Tool and drag it to the desired position. 
 
To resize the Tool, click and hold the right mouse button on the Tool and drag to the desired size.  
 
To setup the Tool properties, double click on the Tool and edit the appropriate fields in the properties 
window. 
 
To cut, copy, paste, or delete a Tool, select the Tool by clicking on it, then click on the Cut, Copy, Paste 
or Delete icons at the top of the window or select Cut, Copy, Paste or Delete from the Edit pull-down 
menu.  
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5.3   Toolbox Tools 

 
The Toolbox contains 18 different Tools, many of which have several different styles.  To open or close 
the toolbox window, click on the toolbox icon, or select Toolbox from the View pull-down menu. 
 
ReDAQ® Shape Software for MAQ®20 offers 18 different types of Tools for building applications: 
 
The Graph group contains: 

• Chart Recorder 

• Scope 

• XY plot 

• Discrete Waveform Graph 
 
The Knob group contains: 

• 5 styles of Knobs 
 
The Meter group contains: 

• 4 styles of Meters 
 
The Gauge group contains: 

• 6 styles of Gauges 
 
The Tank group contains: 

• 6 styles of Tanks 
 
The Slide group contains: 

• 6 styles of Slides 
 
The Thermometer group contains: 

• 6 styles of Thermometers 
 
The NumericEdit group contains: 

• 4 styles of Numeric Edit 
 
The Switch group contains: 

• 14 styles of Pushbutton, Slide, Rocker, and Toggle Switches 
 
The LED group contains: 

• 4 styles of LED 
 
The Other Tools group contains: 

• Label 

• Group Box 

• Picture Box 

• Text Box 
 
 
 
These Tools are based on Controls found in Microsoft Visual Studio or National Instrument’s 

Measurement Studio™.  If more detailed information is required on the Control properties, refer to the 
appropriate Microsoft or National Instruments User Manuals. 
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Each project created within the ReDAQ® Shape Software for MAQ®20 can have up to 12 Tools with high 
level functions, inclusive of (Chart Recorder, Scope, XY Plot and Discrete Waveform Graph) and up to 40 
Tools of all other types. 
 
All the Tools can easily be selected from the Toolbox and inserted into a project.  From there they can be 
moved, resized, cut, copied, pasted, or deleted using simple point and click operations.  Double clicking 
on a given Tool will open the properties window for the Tool where detailed settings can be changed.  
 
 

 
 
 
The Properties window for a Tool is separated into two parts: 
 
The left pane of the property window is where detailed properties such as background, name, font, style, 
color, scale, and layout can be modified. The right pane has a pull-down selection box where inputs or 
outputs for the Tool are selected.  Some of the Tools, such as Picture Box, Text Box, Group Box, and 
Label do not have an input/output select box in their property window because they are used only as 
graphic or text displays. 
 
In the example shown above, the pull-down selection box will show the following default tag names: 
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If 1_VDN_2_0 is selected for the input to the Tank Tool shown above, the tank will display the System 1 
MAQ20-VDN module analog input channel 0. 
 
If the default tag names are changed, the new tag names will appear in the Tool properties window. 
 

5.3.1   Chart Recorder Tool 

 
The Chart Recorder Tool displays data from analog input channels in the MAQ®20 Data Acquisition 
System.  Data can be displayed from multiple channels in multiple modules simultaneously.   
 
To change the Chart Recorder Tool properties, double click on the Chart Recorder to open the Properties 
window.  Only the Appearance, Behavior, Graph, and Layout categories contain parameters that are 
useful to modify when interfacing to the MAQ®20 Data Acquisition System. 
 

• Choose the analog input channels to display in the Chart Recorder Tool by using the checkboxes 
in the Channel Select area of the Properties window. 
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5.3.2   Scope Tool 

 
The Scope Tool displays data from analog input channels in the MAQ®20 Data Acquisition System.  Data 
can be displayed from multiple channels of multiple modules simultaneously. 
 
To change the Scope Tool properties, double click on the scope to open the Properties window.  Only the 
Appearance, Behavior, Graph, and Layout categories contain parameters that are useful to modify when 
interfacing to the MAQ®20 Data Acquisition System. 
 

• Choose the analog input channels to display in the Scope Tool by using the checkboxes in the 
Channel Select area of the Properties window. 
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5.3.3   XY Plot Tool 

 
The XY Plot Tool can display data from analog input channels in the MAQ®20 Data Acquisition System.  
Any channel can be chosen for the X-axis and Y-axis.  The number of samples to display can be 
specified.  Once the number of samples to display has been exceeded, the display will refresh and the 
prior data will be erased.   
 
To change the XY Plot Tool properties, double click on the plot to open the Properties window.  Only the 
Appearance, Behavior, Layout and Scale categories contain parameters that are useful to modify when 
interfacing to the MAQ®20 Data Acquisition System. 
 

• Assign the analog input channel for the X-axis of the display in the XY Plot Tool by using the X 
CH Select pull-down selection box. 

• Assign the analog input channel for the Y-axis of the display in the XY Plot Tool by using the Y 
CH Select pull-down selection box. 

• Specify the number of samples to display in the XY Plot Tool before refresh by entering the 
number in the Plot Samples box. 
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5.3.4   Discrete Waveform Graph Tool 

 
The Discrete Waveform Graph Tool displays the data for discrete input channels in the MAQ®20 Data 
Acquisition system.  The X-axis represents the number of samples collected from the system and is 
shown at the top of the display and the Y axis shows the logic states 0 or 1 for the channels.  Data can be 
displayed or hidden using the +/- box at the top left corner of the plot.  The horizontal hash mark in the 
left-hand legend represents the midscale value for each channel for determination of channel low/high 
state. 
 
To change the Discrete Waveform Graph Tool properties, double click on the device to open the 
Properties window.  Only the Appearance, Graph, Layout, and Scroll Bar categories contain parameters 
that are useful to modify when interfacing to the MAQ®20. 
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5.3.5   Knob Tool 

 
The Knob Tool outputs data to analog output channels in the MAQ®20 Data Acquisition System. 
 
To change the Knob Tool properties, double click on the knob to open the Properties window.  Only the 
Appearance, Behavior, Layout, and Scale categories contain parameters that are useful to modify when 
interfacing to the MAQ®20 Data Acquisition System. 
 

• Assign the analog output channel to send data to with the Knob Tool by using the Knob Output 
pull-down selection box. 
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5.3.6   Meter Tool 

 
The Meter Tool displays data from analog input channels in the MAQ®20 Data Acquisition System. 
 
To change the Meter Tool properties, double click on the Meter Tool to open the Properties window.  Only 
the Appearance, Behavior, Layout, and Scale categories contain parameters that are useful to modify 
when interfacing to the MAQ®20 Data Acquisition System. 
 

• Assign the analog input channel to display in the Meter Tool by using the Meter Input pull-down 
selection box. 
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5.3.7   Gauge Tool 

 
The Gauge Tool displays data from analog input channels in the MAQ®20 Data Acquisition System. 
 
To change the Gauge Tool properties, double click on the Gauge Tool to open the Properties window.  
Only the Appearance, Behavior, Layout, and Scale categories contain parameters that are useful to 
modify when interfacing to the MAQ®20. 
 

• Assign the analog input channel to display in the Gauge Tool by using the Gauge Input pull-down 
selection box. 
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5.3.8   Tank Tool 

 
The Tank Tool displays data from analog input channels in the MAQ®20 Data Acquisition System. 
 
To change the Tank Tool properties, double click on the Tank Tool to open the Properties window.  Only 
the Appearance, Behavior, Layout, and Scale categories contain parameters that are useful to modify 
when interfacing to the MAQ®20 Data Acquisition System. 
 

• Assign the analog input channel to display in the Tank Tool by using the Tank Input pull-down 
selection box. 
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5.3.9   Slide Tool 

 
The Slide Tool performs both input and output functions for analog I/O channels in the MAQ®20 Data 
Acquisition System.  If an analog input channel is assigned to the Tool, the slide position represents the 
analog input channel reading.  If an analog output channel is assigned to the Tool, moving the slide will 
generate a scaled output to the assigned analog output channel.   
 
To change the Slide Tool properties, double click on the Slide Tool to open the Properties window.  Only 
the Appearance, Behavior, Layout, and Scale categories contain parameters that are useful to modify 
when interfacing to the MAQ®20 Data Acquisition System. 
 

• Assign the analog I/O channel to in the Slide Tool by using the Slide Input/Output pull-down 
selection box. 
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5.3.10   Thermometer Tool 

 
The Thermometer Tool displays data from analog input channels in the MAQ®20 Data Acquisition 
System. 
 
To change the Thermometer Tool properties, double click on the Thermometer to open the Properties 
window.  Only the Appearance, Behavior, Layout, and Scale categories contain parameters that are 
useful to modify when interfacing to the MAQ®20. 
 

• Assign the analog input channel to display in the Thermometer Tool by using the Thermometer 
Input pull-down selection box. 
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5.3.11   Numeric Edit Tool 

 
The Numeric Edit Tool performs both input and output functions for analog I/O channels and for discrete 
I/O channel special functions in the MAQ®20 Data Acquisition System.  If an analog input channel is 
assigned to the Tool, it will display the analog input channel reading.  If an analog output channel is 
assigned to the Tool, data entered in the numeric edit box will be output to the assigned analog output 
channel.  Another option is to assign the Numeric Input/Output to one of the discrete I/O channel special 
functions.  Options are; Frequency, Pulse, Event, Duty Cycle, Period, Low Time, Width, Average, and 
Maximum or Minimum special functions either on Timer 0 or Timer 1.  When this assignment is made, the 
Numeric Edit Tool will either display data from a special function such as frequency or counts, or can be 
used as input to a special function such as PWM Generation or One-Shot Pulse.  For more information on 
discrete I/O special functions, refer to the MAQ®20 Hardware User Manual for the MAQ20-DIO module. 
 
To change the Numeric Edit Tool properties, double click on the text field to open the Properties window.  
Only the Appearance, Layout, and Behavior, categories contain parameters that are useful to modify 
when interfacing to the MAQ®20. 
    
A Numeric Edit Tool property of interest is FormatMode under the Behavior category.  Clicking on this 
allows the user to change the numeric format to Binary, Engineering, Generic, Hexadecimal, Scientific, or 
SimpleDouble.  
 

• Assign the analog I/O channel or discrete I/O channel special function to the Numeric Edit Tool 
using the Numeric Input/Output pull-down selection box. 
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5.3.12   Switch Tool 

 
The Switch Tool is a multiple output device that can have up to four outputs which can each be set up 
with the following functions: 
 

• Set discrete output, channels, to 1 = On or 0 =Off.  

• Set analog output channels to a preset, non-zero value of 1 = On or 0 = Off.  
 
The Switch Tool can be configured to one of three Switch Types:  On/Off, On Only, or Off Only. 
 
For example, to use one switch as an On function and another as an Off function, set one as Switch Type 
On Only and the other as Switch Type Off Only, then connect them to the same discrete or analog output 
channel. 
 
To change the Switch Tool properties, double click on the Switch to open the Properties window.  Only 
the Appearance and Layout categories contain parameters that are useful to modify when interfacing to 
the MAQ®20 Data Acquisition System.     
 

• A single Switch Tool can connect to up to four outputs.  To select the Switch output function, first 
select Out 1 through Out 4, then choose the channel to Tool from the Switch Output selection 
box.  The default setting is Out 1 set to DIO0 and Out 2, Out 3 and Out 4 set to Close. 

• One of three button output types are selected using the Switch Type selection box. 

• The preset the value to output from an Analog Output channel is entered into the Analog Output 
Value box. The default setting is 2.5V. 

 
 

 
 

  



MA1038  ReDAQ® Shape Software for MAQ®20 User Manual 

 

 Page 49 of 66 

5.3.13   LED Tool 

 
The LED indicator Tool can be used to monitor discrete input channels or analog input channels.  A 
discrete input channel value of 1 turns the LED on and a value of 0 turns the LED off.  An analog input 
channel value greater than a user selected preset value turns the LED on and a value less than the 
preset value turns the LED off.  Multiple LED’s can be connected to the same digital or analog input 
channel.   
 
To use an LED in a project, select it from the Toolbox and place it on the Present panel.  Select the input 
channel to monitor from the LED Input selection box.  If the LED is to be assigned to an analog input 
channel, enter the preset value which represents the ‘On’ state’ in the Analog input on value box.  To 
change the size, adjust the text font under the Font heading in the Properties box. 
 
Double click on the LED to open the Properties box.  Only the Appearance and Layout categories contain 
parameters that are useful to modify when interfacing to the MAQ®20 Data Acquisition System.   
 

 
 
Example 1: 
Place three separate LED Tools on the Present panel. 
Connect the input for each of the three LEDs to analog input channel 1_VDN_1_0. 
For LED #1, enter a preset AI on value of 1.0 
For LED #2, enter a preset AI on value of 2.0 
For LED #3, enter a preset AI on value of 3.0 
 
As the input to channel 1_VDN_1_0 increases, LED #1 will turn on when the 1_VDN_1_0 reading 
exceeds 1.0V, LED #2 will turn on when the 1_VDN_1_0 reading exceeds 2.0V, and LED #3 will turn on 
when the 1_VDN_1_0 reading exceeds 3.0V. 
 
As the input to channel 1_VDN_1_0, LED #3 will turn off when the 1_VDN_1_0 reading is equal to or less 
than 3.0V, LED #2 will turn off when the 1_VDN_1_0 reading is equal to or less than 2.0V, and LED #1 
will turn off when the 1_VDN_1_0 reading is equal to or less than 1.0V. 
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5.3.14   Label Tool 

 
The Label Tool allows creation of short text labels which can be placed anywhere on the Present panel to 
document, notate or clarify a project.  To use a Label, select it from the Toolbox and place it on the 
Present panel.  Default text for the Label is ‘Label’.  To modify this, double click the box to open the 
Properties box, then, under the Appearance heading and Text item, enter the desired text.  The Label 
Tool cannot be resized by right clicking and dragging as for other Tools.  To change the size, adjust the 
text font under the Font heading in the Properties box. 
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5.3.15   Group Box Tool 

 
The Group Box Tool is used to draw a box around a group of Tools on the Present panel.  It does not 
affect interaction between Tools or project execution.  To use a Group Box, select it from the Toolbox and 
place it on the Present panel.  Once placed, the box can be resized to encompass any of the Tools 
placed in a project.  If desired, Group Box properties can be modified by double clicking the box and 
opening the Properties box.   
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5.3.16   Picture Box Tool 

 
The Picture Box Tool can be used to display any type of image file on the Present panel, including 
photographs of objects or graphs and plots.  All common formats are supported.  To open an image file, 
select the Picture Box Tool from the Toolbox and place it on the Present panel.  Next, double click the 
item to open the Properties box.  Image selection is made under the Appearance heading and Image 
item. 
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5.3.17   Text Box Tool 

 
The Text Box Tool places a box on the Present panel where notes or instructions can be written.  To use 
a Text Box, select it from the Toolbox and place it on the Present panel.  Once placed, text can be added 
by placing the cursor in the Text Box and typing.  If desired, Text Box properties can be modified by 
double clicking the box and opening the Properties box. 
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6.0   Quick Start Examples 

6.1   Closed Loop Control 

 
This closed loop control example demonstrates the implementation of a “bang-bang” temperature 
controller.  It sets the temperature of a material to 75oC with a deadband of 2oC.  The controller uses a 
discrete output channel to turn on a heater when the process first starts.  When the temperature of the 
material reaches 75oC, the heater will turn off.  Once the temperature cools down to 73oC, the heater will 
turn on again.  As long as the process is running, the temperature “bang-bang” controller will keep the 
temperature of the material between 73oC and 75oC.  

 
Step 1: Install a J-Type Thermocouple Input Module [MAQ20-JTC] configured with -100oC to +199oC 
input range in analog input channel 0, 1_JTC_1_0, to monitor the temperature.  Install a Discrete I/O 
Module [MAQ20-DIOL] for output. 
 
  

 
 
ReDAQ® Shape Software for the MAQ®20 Data Acquisition System will automatically set up the scale and 
units for the -JTC module on the Scale Data tab.  
 
 

 
 

 
Step 2: On the Analyze Panel, Analog Input [AI] tab, set the Control Loop/Alarm Output to Tracking H 
(tracking mode and high alarm). 
 
 

 
 
 
The software will jump to the Control Loop/Alarm Output tab to allow the output limit parameters to be set. 
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Step 3: In the Control Loop/Alarm Output tab, set the following parameters: 
 
Config:            Active L      (Tool output active low) 
Output to Channel      1_DIOL_Out_4_0     (Discrete output channel 0 controls the heater) 
High Limit           75       (75oC high limit)  
High Deadband 2       (2oC deadband) 
 
 

 
 
 
Step 4: Using the Present panel: 

• Select a Thermometer Tool from the Toolbox to monitor the material temperature and place it on 
the panel.  Open the Properties window of the Tool and set the range of the Tool to 0-100oC 
using the Scale category of the Properties window and assign analog input channel 1_JTC_1_0 
to the Tool using the Thermometer Input pull-down selection box.  

• Select an LED Tool from the Toolbox to monitor the 1_DIOL_Out_4_0 output and place it on the 
panel.  Open the Properties window of the Tool and enter the caption “Set: 75C” in the 
Appearance category.  

• Select a Label Tool from the Toolbox to make a title for the project and place it on the panel.  
Open the Properties window of the Tool and enter “Example: A “bang-bang” temperature 
controller” in the Appearance category. 

 

 
 
Step 5: Set up the Acquire panel Communications tab parameters to match the settings on the MAQ®20 
Data Acquisition System and on the host computer.  This includes System, Slave ID, choice of TCP/IP or 
Serial communications, IP address, Port Name, Baud Rate, and Parity.   
 
Connect a J-Type thermocouple to channel 0 of the MAQ20-JTC module.  Affix the thermocouple to the 
material for which the temperature is to be controlled.  Connect the MAQ20-DIOL discrete output channel 
to an appropriate active low switch.  Connect the switch and power to a heater.  Place the heater in 
contact with the material.  Check all connections, then click Start to run the controller.  
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6.2   PID – Tank Level Controller 

 
ReDAQ® Shape Software for MAQ®20 provides a simple interface to the MAQ®20 Data Acquisition and 
Control System. An extensive toolbox in the software has a specialized PID Controller Faceplate as well 
as numerous buttons, switches, graphs, indicators, and other devices for controlling and monitoring a 
process. 
 
The PID Controller provides real-time closed-loop control of industrial processes and equipment by 
comparing process output and setpoint values. The chosen PID algorithm then minimizes this error by 
adjusting the proportional (P), Integral (I), and Derivative (D) terms over time until the desired operating 
point is reached. The controller then maintains stable process operation over setpoint changes and 
process variations. The Noninteractive Control Algorithm is shown below and control algorithms are 
detailed in Section 7.2 of the MA1056 MAQ20 PID Controller User Manual. 
 
 

 
A typical Level Control application which uses MAQ®20 hardware and ReDAQ® Shape Software for 
MAQ®20 is shown below.  In this example, a MAQ20-IDN process current input module monitors the 
liquid level in the tank and provides the Process Variable (PV) while the MAQ20-IO current output module 
provides the Controller Output (CO).  
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A powerful function integrated in the MAQ20-940 ReDAQ® Shape Software for MAQ®20 is an Auto- 
Tuner which is used to simplify the complex task of control loop tuning. To run the Auto-Tuner, first 
configure the system and the PID Controller. Next, Run the system and click the [Settings] button 
in the lower left corner of the PID Controller Faceplate.  
 

 
 
 
From the Basic Settings tab, click the [Auto Tune] button in the middle of the window. The PID Controller 
Auto-Tune interface will open as shown in the image below.  
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The tuning process is initiated by clicking the [Start] button in the lower left corner of the window. When 
the tuning process runs, the Auto-Tune Details window opens and lists the tuning process steps as they 
occur, displaying measured results. If the process is stable and can be tuned, the Auto-Tuner will 
converge and a message box will indicate success. 
 
The current and new values for the controller parameters are displayed in the lower right potion of the 
Auto-Tuner window. To apply these optimized values to the controller, press the [Activate New Values] 
button. The new controller parameters can be tested by closing the Auto-Tuner windows, adjusting the 
Setpoint, and observing the controller response. Default values for some Auto-Tuner parameters such as 
PV deviation limits and CO step limits may need to be adjusted for the tuning process to converge. Start 
with the default values, tune the controller, and observe the messages in the Auto-Tune Details window 
for recommendations on parameter changes. 
 
 

6.2.1   PID – Temperature and Flow Controller 

A typical occurances in industrial manufacturing is the failure of controllers on legacy equipment.  Direct 
replacement of controllers for legacy equipment can be difficult and almost impossible in cases where 
custom firmware was used on the discontinued system.  The MAQ®20 Data Acquisition and Control 
System is a low-cost option for use in such applications. The methods outlined within Section 6.2 of this 
document were implemented in regards to an industrial PID process simulator that was previously used 
for educational purposes and no longer functional. 
 
The industrial process simulator hardware is composed of a variable speed fan directed towards heating 
coils located in the center of an insulated tube. An RTD sensor located near the coils was used for 
temperature measurement and a transmitter at the end of the insulated tube was used to measure the 
pressure of the airflow exiting the system in pascals.  

 

 
 
Outputs and inputs to the flow and heating hardware are standard process currents of 4-20mA and were 
previously wired to individual PID controllers on the faceplate of the device.   
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Inputs and outputs from the PID controllers were removed and connected to a single MAQ®20 Data 
Acquisition System. A MAQ20-IDN module was used for monitoring system response as the product 
variable (PV) through current input and a MAQ20-IO was used to provide system excitation as the control 
output (CO). 
 
A present panel was developed in ReDAQ® Shape Software to mimic the aesthetics and active PID 
display outputs of the non-functioning industrial electronic equipment. This was done using images of the 
equipment as a background and overlaying application graphical user interfaces (GUIs) from ReDAQ® 

Shape Software’s Toolbox selection.  
 

 
 
All functionality provided by physical inputs to the industrial process simulator were mirrored by the 
interactive GUIs from ReDAQ® Shape Software’s Toolbox selection.  This allowed for remote control of 
the system through the MAQ®20 Data Acquisition System’s ethernet TCP interface.  Two PID faceplates 
were used for control of the PID processes, while additional functionalities were provided by the GUIs 
overlayed on the background image of the industrial hardware. 
 
Like the example shown in Section 6.2 of this document, ReDAQ® Shape Software’s PID Tunning tool 
was used to derive the optimal values related to controller gain and integral time. 
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Upon completion of the tunning process, the PID Control panel tool was set to Auto Mode and was able 
maintain the setpoint specified by the user’s input by varying the output of the associated MAQ20-IO 
channels.  

 

6.3   SCMPB01 Backpanel Display  

The MAQ20-5B26-0.x transition cable can be used to interface a MAQ20-VSN module to one of the 26-

pin ribbon cable connectors located on SCMPB01 and SCMPB05 backpanels. This allows for SCM5B 

modules configured with voltage outputs to be recorded through the 16 channels of the MAQ20-VSN 

voltage input module without the need for complex wiring by the user.  

For demonstration purposes, a present panel with a background image of the SCMPB01 backpanel with 

attached modules was implemented to provide continuous data output from the analog modules. This 

simplistic interface was implemented with the use of the Label and Text Tools from ReDAQ® Shape 

Software’s Toolbox selection. The color of the label backgrounds were set to match the anti-static mat 

that the image of the SCMPB01 backpanel was taken over. 
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Use of the MA20-5B26-0.x cable is only recommended for users who already have an existing stock of 
compatible SCM5B modules and require a method of digital acquisition. When used in this arangement, it 
should be noted that combined accuracy of the system will be sum of SCM5B module accuracy and 
MAQ20-VSN module accuracy.   
 

6.4   Battery Cell Monitor 

 
A system for monitoring potentials of individual and stacked battery cells was implemented with the use of 
a MAQ®20 Data Acquisition System. The system was composed of a MAQ20-COM4 communication 
module, two MAQ20-ISOV2 isolated differential voltage input modules, and a MAQ20-TTC thermocouple 
input module for measuring temperatures of the battery stacks. The modules were placed in a small 
enclosure with connections made to switches, LEDs, and seven segment displays.   
 

 
 
External series resistors were arranged to allow for a total stack voltage of 160 VDC to be measured 
within the channel limits of the MAQ20-ISOV2 isolated voltage input modules. Total battery stack voltage 
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was also displayed discretely through the illumination of the four LEDs on the top left side of the 
enclosure, with four LEDs at full brightness indicating a total stack voltage of 160 VDC. 
 
The example shown below is a present panel that was created using GUIs from the toolbox selection 
within ReDAQ® Shape Software. 
 

 

 

Bar graphs, numeric text output, and LEDs were connected to individual channels of the MAQ20-ISOV2 

modules to provide both visual and continuous data output to the user.  The LED GUIs were configured 

with a tracking low-alarm to indicate a fault condition in the event of a voltage cell dropping below a 

specified level.  Thermocouples were placed on the top, bottom, and center of the battery stack to provide 

temperature data on the present panel.  The image below shows the occurance of faults on cells 14 and 

15, indicated by the illumination of the associated fault LEDs.  
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The MAQ®20 Data Acquisition System can communicate simultaneously through its three available 

communication interfaces, allowing for data to be streamed by multiple software instances from a single 

host system, or by multiple host systems. A Python implementation using the MAQ20 Python API was 

also developed to output individual and total battery stack voltages. 

 

The Python implementation allowed for a more data focused implementation with coarse and fine views 
of the total stack voltage, along with individual cell voltages.  Use of the Python API provides complete 
customization of displayed outputs and control of MAQ®20 Data Acquisition System in ways not always 
possible with ReDAQ® Shape Software.  Additional information on the MAQ®20 Python API can be found 
in the MA1064 MAQ20 Python API User Manual. 

 

6.5   Remote Weather Station 

MAQ®20 Data Acquisition Systems can be used in remote locations when connected to a cellphone 

modem through the MAQ20-COMx’s ethernet interface. To demonstrate this capability, a weather station 

was installed on the roof of Dataforth’s headquarters in Tucson, Arizona. The system was composed of 

the following modules: 

- MAQ20-MVDN: Temperature, humidity, and barometric pressure measurements. 

- MAQ20-VO: Voltage excitation for temperature, humidity, and barometric pressure sensors. 

- MAQ20-RTD31:  Wind direction measurement. 

- MAQ20-FREQ: Wind speed and rain gauge measurements. 

- MAQ20-TTC: Temperature measurements outside and within control cabinet. 
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The hardware and sensors mounted on the roof of the building were connected through a weatherproof 

conduit to an enclosed control box located inside of the building. Given the location of the installment, a 

cellar modem was not required but was used for demonstration purposes.  

 

 

  

 

To demonstrate the flexibility of software integration with the MAQ®20 Data Acquisition System, a present 

panel was developed in in Python using the MAQ20 Python API as an interface.  
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6.6   Process Simulator  

 
To demonstrate the variety of functionalities provided by the MAQ®20 Data Acquisition System, an 

interactive system was designed with the following module population: 

- MAQ20-COM4: Communication Module. 

- MAQ20-JTC: 8-Channel Thermocouple Input Module. 

- MAQ20-VDN: 8-Channel Differential Voltage Module. 

- MAQ20-VO: 8-Channel Voltage Output Module. 

- MAQ20-DIOL: 8-Channel Digital Input/Output Module. 

 

 

 

On the demonstration system, the MAQ20-JTC module Ch 7 measures the thermocouple protruding from 

the Process Simulator.  
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The orange LED bar display is controlled by MAQ20-VO Ch 0.  MAQ20-VDN module Ch 0 measures a 0 

to 3V signal for the green LED bar display, labeled VOUT2. The green LED bar display is controlled by 

Motor Pot 1 when MAQ20-VO Ch 1 is set to -10V and it is controlled by MAQ20-VO Ch 2 when MAQ20-

VO Ch 1 is set to +10V.  

MAQ20-DIOL module input channels DI0 through DI4 are connected to bat toggle switches SW1 through 

SW5 respectively. The discrete input channels read logic 1 for the bat toggle switch in the left position 

and the LED off and logic 0 for the bat toggle switch in the right position and the LED on. MAQ20-DIOL 

module output channels DO1 and DO2 are connected to Motor Pot 1 FWD and REV controls respectively 

and output channels DO3 and DO4 are connected to Motor Pot 2 FWD and REV controls respectively. 

MAQ20-VDN module Ch 0 measures a 0 to 3V signal for the green LED bar display, labeled VOUT2 and 

MAQ20-VDN module Ch 2 measures a 0 to 3V signal for the blue LED bar display, labeled VOUT3. The 

green LED bar display is controlled by Motor Pot 1 when MAQ20-VO Ch 1 is set to -10V and the blue 

LED bar display is controlled by Motor Pot 2 when MAQ20-VO Ch 1 is set to -10V.  

Control of the process simulator occurs through a custom made present panel or by direct interaction with 

the hardware.  Any changes to the digital panel or to the physical the hardware are mirrored at an update 

rate of 10ms.  
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7.0   Advance Features 

7.1   Modbus TCP Logger 

ReDAQ® Shape Software can be configured to record internal Modbus TCP communications to a log file 
during program execution.  This feature must be enabled prior to connecting to the MAQ®20 Data 
Acquisition System through a TCP connection in ReDAQ® Shape Software.   
 
The Modbus Logger feature can be enabled using the view pull-down menu: 
 

 
 

 
 
 
Following program execution, the generated log file can be found in the ReDAQ Shape MAQ20 subfolder 
located within the Dataforth folder in the user’s Documents.   
 

 
 
 
The logfile is populated with timestamped Modbus requests and response data.  Information on 
cumulative retires on Modbus request are also logged within the file.  
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The log file is intended for debugging purposes by the user, or can be provided to Dataforth’s Technical 
Support team if issues with system hardware or software are suspected. 
 
 

7.2   Manual Module Registration Mode 

 
In instances where modules are connected to a system but are not required for use for a given 
application, Manual Registration Mode can be enabled. In this mode, system population does not occur 
automatically, but instead through manual entry of the desired modules by the user.  
 
This feature must be enabled prior to connecting to the MAQ®20 Data Acquisition System.  
 
The option to enable Manual Register Mode can be made visible to the user by selecting the Show 
Manual Registration Mode option in the View pull-down menu:  
 

 
 
 
 
 
A checkbox located underneath the system name will then become visable and can be selected to enable 
Manual Registrtion Mode. 
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Once connected to the MAQ®20 Data Acquisition System, click on the image of the MAQ20-COMx 
module to access the System Summary Tab.  Click the [Manual Register Module] button within the tab 
and an input pop-up screen will appear:  
 

 
 
Clicking the [Add] button after entering the modules serial number and the desired slot number will 
populate the module with the matching serial number in the specified slot number.  The process listed in 
this section can be repeated to add additional modules to the system. 
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DATAFORTH  WARRANTY 
Applying to Products Sold by Dataforth Corporation 

 
a. General. Dataforth Corporation (“Dataforth”) 
warrants that its products furnished under this 
Agreement will, at the time of delivery, be free from 
defects in material and workmanship and will conform 
to Dataforth's applicable specifications or, if 
appropriate, to buyer's specifications accepted in 
writing by Dataforth. DATAFORTH'S OBLIGATION OR 
LIABILITY TO BUYER FOR PRODUCTS WHICH DO 
NOT CONFORM TO THE ABOVE STATED 
WARRANTY SHALL BE LIMITED TO DATAFORTH, 
AT DATAFORTH'S SOLE DISCRETION, EITHER 
REPAIRING, REPLACING, OR REFUNDING THE 
PURCHASE PRICE OF THE DEFECTIVE 
PRODUCT(S) PROVIDED THAT WRITTEN NOTICE 
OF SAID DEFECT IS RECEIVED BY DATAFORTH 
WITHIN THE TIME PERIODS SET FORTH BELOW: 
 
 i. for all software products including licensed 
programs, thirty (30) days from date of initial delivery; 
 
 ii. for all hardware products including complete 
systems, one (1) year from date of initial delivery; 
 
 iii. for all special products, sixty (60) days from 
date of initial delivery; and 
 
further, all products warranted hereunder for which 
Dataforth has received timely notice of 
nonconformance must be returned FOB to Dataforth's 
plant in Tucson, Arizona USA within thirty (30) days 
after the expiration of the warranty periods set forth 
above. 
 
The foregoing warranties shall not apply to any 
products which Dataforth determines have, by buyer or 
otherwise, been subjected to operating and/or 
environmental conditions in excess of the maximum 
value established therefore in the applicable 
specifications, or any products that have been the 
subject of mishandling, misuse, misapplication, 
neglect, improper testing, repair, alteration or damage. 
THE PROVISIONS OF THE FOREGOING 
WARRANTIES EXTEND TO BUYER ONLY AND NOT 
TO BUYER'S CUSTOMERS OR USERS OF BUYER'S 
PRODUCTS. THE DATAFORTH STANDARD 
WARRANTY IS IN LIEU OF ALL WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE OR USE AND ALL OTHER 
WARRANTIES WHETHER EXPRESS, IMPLIED OR 
STATUTORY, EXCEPT AS TO TITLE. THE 
DATAFORTH STANDARD WARRANTY MAY BE 
CHANGED BY DATAFORTH WITHOUT NOTICE. 
 
b. Buyer Indemnity. Buyer agrees to indemnify and 
hold Dataforth harmless from and against any and all 
claims, damages and liabilities whatsoever asserted by 
any person, entity, industry organization, government, 
or governmental agency of any country resulting 

directly or indirectly (i) from any acts not authorized by 
Dataforth in writing or any statements regarding the 
products inconsistent with Dataforth's product 
documentation or standard warranty, or (ii) from any 
breach or threatened breach by buyer, or by any of its 
employees or agents, of any term, condition or 
provision of this Warranty or (iii) from any warranty, 
representation, covenant or obligation given by buyer 
to any third party and not expressly provided for in this 
Warranty or (iv) for any non-compliance (in any form) 
of the products with any necessary or mandatory 
applicable laws, regulations, procedures, government 
or industry policies or requirements related to the use, 
sale or importation of the products.   Such 
indemnification shall include the payment of all 
reasonable attorneys' fees and other costs incurred by 
Dataforth in defending such claim. 
 
c. Limitation on Damages.  
  
(1) IN NO EVENT SHALL DATAFORTH, ITS 
SUPPLIERS, LICENSORS, SERVICE PROVIDERS, 
EMPLOYEES, AGENTS, OFFICERS, AND 
DIRECTORS BE LIABLE FOR INDIRECT, SPECIAL, 
INCIDENTAL, COVER, ECONOMIC, PUNITIVE, 
ACTUAL, EXEMPLARY, CONSEQUENTIAL OR 
OTHER DAMAGES OF ANY NATURE INCLUDING, 
WITHOUT LIMITATION, LOST PROFITS OR 
REVENUES, COSTS OF REPLACEMENT 
PRODUCTS, LOSS OR DAMAGE TO DATA ARISING 
OUT OF THE USE OR INABILITY TO USE ANY 
DATAFORTH PRODUCT.  
 
(2) IN NO EVENT SHALL DATAFORTH BE LIABLE 
FOR DIRECT, SPECIAL, INDIRECT, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES OF ANY NATURE 
RESULTING FROM BUYER’S NONCOMPLIANCE 
(IN ANY FORM) WITH ALL NECESSARY OR 
MANDATORY APPLICABLE LAWS, REGULATIONS, 
PROCEDURES, GOVERNMENT POLICIES OR 
REQUIREMENTS RELATED TO THE USE, SALE OR 
IMPORTATION OF PRODUCTS. 
 
(3) IN NO EVENT WILL THE COLLECTIVE LIABILITY 
OF DATAFORTH AND ITS SUPPLIERS, 
LICENSORS, SERVICE PROVIDERS, EMPLOYEES, 
AGENTS, OFFICERS, AND DIRECTORS TO ANY 
PARTY (REGARDLESS OF THE FORM OF ACTION, 
WHETHER BASED UPON WARRANTY, 
CONTRACT, TORT, OR OTHERWISE) EXCEED THE 
GREATER OF EITHER US$1000.00 (ONE 
THOUSAND DOLLARS U.S.A. CURRENCY) OR THE 
AMOUNT PAID TO DATAFORTH FOR THE 
APPLICABLE PRODUCT OR SERVICE OUT OF 
WHICH LIABILITY AROSE. 
 
(4) DATAFORTH’S LIABILITY ARISING OUT OF THE 
PRODUCTION, SALE OR SUPPLY OF PRODUCTS 
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OR THEIR USE OR DISPOSITION, WHETHER 
BASED UPON WARRANTY, CONTRACT, TORT OR 
OTHERWISE, SHALL NOT EXCEED THE GREATER 
OF EITHER US$1000.00 (ONE THOUSAND  
DOLLARS U.S.A. CURRENCY) OR THE ACTUAL 
PURCHASE PRICE PAID BY BUYER FOR 
DATAFORTH'S PRODUCTS. DATAFORTH'S 
LIABILITY FOR ANY CLAIM OF ANY KIND SHALL IN 
NO CASE EXCEED THE OBLIGATION OR LIABILITY 
SPECIFIED IN THIS WARRANTY.  
 
d. Technical Assistance. Dataforth 's Warranty as 
hereinabove set forth shall not be enlarged, diminished 
or affected by, and no obligation or liability shall arise 
or grow out of, Dataforth's rendering of technical 
advice, facilities or service in connection with buyer's 
order of the products furnished hereunder.  
 
e.  Warranty Procedures. Buyer shall notify 
Dataforth of any products which it believes to be 
defective during the applicable warranty period and 
which are covered by the Warranty set forth above. 
Buyer shall not return any products for any reason 
without the prior authorization of Dataforth and 
issuance of a Return Material Authorization ("RMA") 
number. After issuance of a RMA number, such 
products shall be promptly returned by buyer (and in 
no event later than thirty (30) days after the Warranty 
expiration date), transportation and insurance prepaid, 
to Dataforth's designated facility for examination and 
testing. Dataforth shall either repair or replace any 
such products found to be so defective and promptly 
return such products to buyer, transportation and 
insurance prepaid. Should Dataforth's examination and 
testing not disclose any defect covered by the 
foregoing Warranty, Dataforth shall so advise buyer 
and dispose of or return the products in accordance 
with buyer's instructions and at buyer's sole expense, 
and buyer shall reimburse Dataforth for testing 

expenses incurred at Dataforth's then current repair 
rates. 
  
f. Repair Warranty. Dataforth warrants its repair 
work and/or replacement parts for a period of ninety 
(90) days from receipt by buyer of the repaired or 
replaced products or for the remainder of the warranty 
period for the initial delivery of such order as set forth 
in paragraph a above, whichever is greater. 
 
g. Critical Applications. Certain applications using 
Dataforth's products may involve potential risks of 
death, personal injury, or severe property or 
environmental damage ("Critical Applications"). 
DATAFORTH'S PRODUCTS ARE NOT DESIGNED, 
INTENDED, AUTHORIZED, OR WARRANTED TO BE 
SUITABLE FOR USE IN LIFE-SUPPORT DEVICES 
OR SYSTEMS, SAFETY EQUIPMENT, NUCLEAR 
FACILITY APPLICATIONS OR OTHER CRITICAL 
APPLICATIONS WHERE MALFUNCTION OF THE 
PRODUCT CAN BE EXPECTED TO RESULT IN 
PERSONAL INJURY, DEATH OR SEVERE 
PROPERTY DAMAGE. BUYER USES OR SELLS 
SUCH PRODUCTS FOR USE IN SUCH CRITICAL 
APPLICATIONS AT BUYER'S OWN RISK AND 
AGREES TO DEFEND, INDEMNIFY AND HOLD 
HARMLESS DATAFORTH FROM ANY AND ALL 
DAMAGES, CLAIMS, PROCEEDINGS, SUITS OR 
EXPENSE RESULTING FROM SUCH USE.  
 
h. Static Sensitive. Dataforth ships all product in 
anti-static packages. Dataforth's Warranty as 
hereinabove set forth shall not cover warranty repair, 
replacement, or refund on product or devices damaged 
by static due to buyer's failure to properly ground. 
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Application Support 
 
Dataforth provides timely, high-quality product support. Call 1-800-444-7644 TOLL-FREE. 

 
 

Returns/Repair Policy 
 
All warranty and repair requests should be directed to the Dataforth Customer Service Department at 
(520) 741-1404. If a product return is required, request a Return Material Authorization (RMA) number. You 
should be ready to provide the following information: 
 
1.  Complete product model number. 
2.  Product serial number. 
3.  Name, address, and telephone number of person returning product. 
4.  Special repair instructions. 
5.  Purchase order number for out-of-warranty repairs. 
 
The product should be carefully packaged, making sure the RMA number appears on the outside of the 
package, and ship prepaid to: 
 
Dataforth Corporation 
3331 E.  Hemisphere Loop 
Tucson, AZ 85706 USA 
 
The information provided herein is believed to be reliable; however, DATAFORTH assumes no responsibility for 
inaccuracies or omissions. DATAFORTH assumes no responsibility for the use of this information, and all use of such 
information shall be entirely at the user's own risk. Application information is intended as suggestions for possible use 
of the products and not as explicit performance in a specific application. Prices and specifications are subject to 
change without notice. No patent rights or licenses to any of the circuits described herein are implied or granted to 
any third party. DATAFORTH does not authorize or warrant any DATAFORTH product for use in life support devices 
and/or systems. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MAQ®20 ReDAQ® Shape for MAQ®20 User Manual 
MA1038 Rev. E – November 2023 
© 2023 Dataforth Corporation.  All Rights Reserved. 
ISO9001:2015-Registered QMS 


